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All rights reserved, including those to reproduce this manual or parts •	
thereof in any form without permission from Shimadzu Corporation. 

The information in this manual is subject to change without notice and does •	
not represent a commitment on the part of the vendor.

Any errors or omissions which may have occurred in this manual despite •	
the utmost care taken in its production will be corrected as soon as 
possible, although not necessarily immediately after detection.

Maintenance parts for this product are provided for seven years after •	
production has stopped. Please note that we may not be able to provide 
maintenance parts after this period. However, for parts that are not genuine 
Shimadzu parts, the period of provision is determined by the manufacturer.

The contents of the hard disk in a PC can be lost due to an accident. •	
Backup your hard disk to protect your important data from accidents.

If the user or usage location changes, ensure that this Instruction Manual is •	
always kept together with the product.

©2010 Shimadzu Corporation. All rights reserved.

NOTICES
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Types of Manuals
Five Instruction Manuals are provided with LabSolutions.
You can also display the [Help] menu to confirm the meanings 
and setting ranges of parameters. 
The following shows how to make full use of the manuals.

Getting Started Guide��
This manual is for first-time users.
Follow the sequence of procedures in this guide to gain 
an understanding of basic LabSolutions operations.

Operators Guide��
This manual gives comprehensive 
information about overall 
data acquisition operations in 
LabSolutions, such as system 
configuration, data analysis, batch 
processing, and report functions.

System Users Guide��
This manual is for system 
administrators. 
This manual describes system 
administration and data 
management.

Data Acquisition & ��
Processing Theory Guide
This manual describes peak 
detection and quantitation of sample 
components (for advanced users).

Installation & ��
Maintenance Guide
This manual describes installation 
and maintenance of the LabSolutions 
software.

Help��
Refer to [Help] to learn more about 
the displayed sub-window. 
Click the on-screen [Help] button 
or the [F1] key on the keyboard to 
display [Help]. 

The meanings of symbols used in this manual are 
as follows.

b
Useful advice for convenient 
instrument operation

B
Shows where to refer to in the 
Operators Guide
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What LabSolutions Can Do
LabSolutions software is very easy to use, while incorporating high-grade functions.
It provides powerful support for automating and improving the efficiency of sequential 
data acquisition and analysis operations.
Use LabSolutions to perform the following functions.

Control of analytical instruments and data acquisition•	
Data analysis and viewing of data•	
Creation and printing of various customizable reports•	

System Structure
This Getting Started Guide describes data acquisition operations with the assumption 
that the system includes the following instruments.

Gas Chromatograph GC-2010
Autosampler•	 AOC-20i

Split/Splitless•	 Injection unit (SPL)

Capillary column: •	 Stabilwax 30 m × 0.32 mm I.D, 0.5 µm-thick film

Flame ionization detector (FID)•	
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File Types

Data file (.gcd)

This file contains all analysis results and acquisition information from the following files.

Method file (.gcm)

Acquisition conditions,  
analysis conditions,  
calibration curve information, 
and etc.

Batch file (.gcb)

This file is used for
continuous data acquisition
of sequential samples.

Report format file (.lsr)

This file is used to print
data acquisition results.
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Set up the data acquisition 
conditions to suit the 
component to be measured.
Before starting data acquisition, set up the data 
acquisition conditions on LabSolutions.
For the data analysis operations described in this 
manual, set as follows:

Column oven 
temperature

50 °C (3 min retention) 
→ 150 °C (2 min retention) 
(temperature rise speed 10 °C/min)

Injection unit 
temperature

250 °C

Carrier gas He, linear velocity 40 cm/sec, 
linear velocity mode

Sample injection 
method

Split method

Split ratio	 1:25

Detector 
temperature

250 °C

Sample Alcohol mixed samples, 100, 500 and 
1000 ppm standard samples, and 2 
unknown samples

When you have finished setting up the data 
acquisition conditions, 

start off by acquiring the data.

On LabSolutions, the operation of analysis samples 
one at a time is called "single run".

To evaluate the data acquisition conditions, change 
the data acquisition conditions, measure standard 
samples and unknown samples, and check the 
separation state of the target component. 

Perform data acquisition on other samples using 
the data acquisition conditions that provided the 
optimum separation state. 

B 3 single run P.24

Set Up the 
Conditions

STEP 2
Data 

Acquisition

STEP 1

-Checks Before Operation-

Data Acquisition Flow
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Process the acquired data, and 

apply the analysis conditions.

Normally, multiple data is analyzed to determine 
peak integration conditions so that consistent results 
(e.g. repeatability of retention time and peak area, 
detection limits of target components, and linearity) 
can be acquired.

When the data analysis conditions have been fixed, 
quantitative calculation (i.e. investigation as to how 
much of the target component is contained in the 
sample) is performed on the unknown sample based 
on the data analysis results of the acquired standard 
sample.

To perform quantitation, a calibration curve must be 
made from the known concentrations and peak area 
values of the standard samples. This calibration 
curve is used to calculate the concentration of the 
unknown sample.

B 4 Data Analysis P.26

Perform data acquisition on 
sequential samples together. 

Realtime batch is performed to measure sequential 
samples continuously when the data acquisition 
conditions have been fixed by performing a single 
run. 

B 5 Realtime Batch P.32

B 6 Multiple Data Analysis P.40

STEP 3
Analysis

STEP 4
Realtime

Batch

Setting up the data acquisition conditions and 
optimizing the data processing parameters are 
important for obtaining better data acquisition results. 
This section describes the basic flow of data analysis.
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LabSolutions Main Window

[Data Acquisition] 
window

for acquiring data

[Realtime Batch] 
window

for realtime batch
processing

[Data Analysis] 
window

for analyzing data

[Quant Browser] 
window

for analyzing data
from multiple

samples

 LabSolutions Main Programs and Main Windows

[Realtime Analysis]  
program

[Browser] 
program

[Postrun]
Displays the icons for the [Postrun Analysis] program 
(data analysis), and the [Browser] program 
(chromatogram display and quantitative calculation of 
results).

[Instruments]
The analytical instruments connected to the PC are displayed as icons.

Double-click  to start the [Realtime Analysis] program where data 

acquisition settings are set and data is acquired.

[Administration]
Displays the icons of the system administration 
programs for setting security policies, user 
administration and the log browser.

[Manual]
Displays the icons for the various PDF manuals and 
Help menu provided with LabSolutions.

[Postrun Analysis] 
program
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 LabSolutions Windows

The following example describes the 
[Realtime Analysis] program window.

Title Bar
This bar displays the names of the current program, window, loaded file, and other information.

Menu Bar
This bar displays the current window and menus that are available based on the operating rights of the current user.

Toolbar
This bar displays icons of frequently used menu items and icons for operating analytical instruments.

1

Assistant Bar
This bar displays 
icons for frequently 
used data acquisition 
operations.

Data Explore
This sub-window 
displays the names 
of files in the selected 
folder.

2
Window
In the [Realtime Analysis] program, [Data Acquisition], 
[Realtime Batch] and other windows are displayed as icons 
on the assistant bar.
In the [Postrun Analysis] program, [Data Analysis], 
[Calibration Curve], [Report Format] and other windows are 
displayed. Switch the windows by clicking the icons on the 
assistant bar. Instrument Monitor (right side of the window) 
check the acquisition conditions and connections.

3

Output Window
This window displays an operation history and error messages that occur.

4

2

1

3

4
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 How to Open Windows

Set the Data Acquisition Parameters and Execute a Single Run:
Open the [Data Acquisition] window from the main window.

▲Main Window

▼[Realtime Analysis] program
1

2

▼[Data Acquisition] window

Continuous Data Acquisition of Sequential Samples:
Open the [Realtime Batch] window from the main window.

1

▲Main Window

▼[Realtime Batch] window

▼[Realtime Analysis] program2

B 2 Set the Instrument Parameters 
P.18

B 3 Single Run P.24

3

3

B 5 Realtime Batch P.32
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Data Analysis and Quantitative Calculations:
Open the [Data Analysis] window from the main window.

2

▲Main Window

▼[Postrun Analysis] program

▼[Data Analysis] window

1

Multiple Data Analysis and Quantitative Calculations:
Open the [Quant Browser] window from the main window.

1

2

3

▲Main Window

▼[Browser] program

▼[Quant Browser] window

3

B 4 Data Analysis P.26

B 6 Multiple Data Analysis P.40
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1	 Supply gas to the GC.
Open the main valve of the carrier gas and other gases to supply gas to the GC. 

2	 Turn the GC and peripheral devices on. 

3	 Turn the PC and printer on. 
Verify that the [LabSolutions Service] icon in the systray on the taskbar is green after 
the PC starts up.

If the icon is yellow, this means that LabSolutions is in the process of starting up. 
Wait a while.
If the icon is red, this means that an error has occurred. Restart the PC.

Start Up
This chapter describes how to start up LabSolutions.

�$$ Refer to "GC Data Acquisition" in Operators Guide for details on the "Data Acquisition" 
window.

Chapter

1
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1  Start Up

4	Double-click  on the desktop.
The [Login] sub-window opens.

5	 Log in.

1

2

Enter "Admin".

6	Open the [Realtime Analysis] program.

1 2

Continued on the following page
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7	Open the [Data Acquisition] window.

�DD Click here if the [Main] assistant bar is not 
displayed.

8	Check the status.

In a normal state, [Not Ready] or [Ready] is displayed 
for the status.
Follow the recommendations below if  
[Not Connected] is displayed.

Ensure that the power is ON.•	
Ensure that instruments are connected correctly.•	
Ensure that the system configuration settings are •	
correct.

B  P.16 for details.
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1  Start Up

9	 Start the GC.

1

2

This message sometimes 
is not displayed. 

Make sure that [Ready] is displayed 
for the status after the GC temperature 
and other preset values are reached. 
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LabSolutions

SUPPLEMENT
"I want to connect to the system."
"I want to change the system configuration."

In such cases

Re-Set the System Configuration.

1	Open the [System Configuration] sub-window.

�DD Click here if the [Main] assistant bar is not 
displayed.

The [System Configuration] sub-window opens.
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1  Start Up

2	 Set up communications.

1

2 3

The [Instrument] sub-window opens.

Select the GC to use. Click 

4

5

Select [RS-232C] and [COM Port].

Click here to display each instrument 
currently connected to the GC at 
[Modules Used for Analysis] in the 
[System Configuration] sub-window. 

3	Check that the system configuration is correct.

1

2

Double-click the unit, 
and set the properties 
of each unit. 

Click here to send the settings to the GC.
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1	Open the [Data Acquisition] window.

2	 Set the items on the [GC] tab. 

2
1

3

5

INJ1	 :	 250.0 °C 
Column Oven	 :	 50.0 °C 
DET1	 :	 250.0 °C

Linear Velocity	:	40.0 cm/sec
Split Ratio	 :	25.0

Click here to set the control mode. 
Control mode	 :	 Linear Velocity

4

�$$ Refer to P.6 for details on data acquisition conditions.

�$$ Refer to "Set the Instrument Parameters" of the "GC Data Acquisition" chapter in Operators Guide for details 
on instrument parameters. 

Set the Instrument Parameters
The data acquisition method (instrument parameters) are saved to the method file after 
they have been set in [Instrument Parameters View] in the [Data Acquisition] window.
This chapter explains how to set the instrument parameters.

Chapter

2
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2  Set the Instrument Parameters

3	 Edit the Time Table for the column temperature program. 

1 3
2

Rate Temperature Hold time

0 - 50.0 3.00

1 10.00 150.0 2.00

Click here to display 
the column temperature 
program as a graph.

4	 Set the injection volume.

1

2

Injection Volume : 1.0 µL

Continued on the following page
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5	 Save the data acquisition conditions.

1

32

Enter "Tutorial_Method".

The folder initially displayed here is the 
default folder. 
To change the default folder, 

"Default Folder and $$ Change the 
Default Folder" P.23

4

Click here to download the 
data acquisition conditions 
to the instrument.
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2  Set the Instrument Parameters

LabSolutions

SUPPLEMENT Baseline Check
By the baseline check, you can check whether or not noise and drift values on the 
baseline are within the preset time and at the threshold or below. 
Baseline check parameters are saved in the method file.

1	 Set [Baseline Check Parameters].

1

3
2

4

Set both [Noise] and [Drift] to  , and enter 
[Start], [End] and [Threshold].

In the [Baseline Check] sub-window, the noise calculation method can be changed, and the maximum delay 
time when the result of the baseline check is [Fail] within the preset time. B  Help for details.
�DD

2	 Perform the baseline check.

1

After measurement ends, the check results are displayed in [Baseline Check Results] sub-window and 
[Output Window].

[Output Window]

Baseline Check Results
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LabSolutions

SUPPLEMENT
Slope Test
By performing the Slope Test, the peak detection sensitivity (Slope value) of peak 
integration parameters can be automatically set from the status of the noise and 
drift appearing on the chromatogram before data acquisition. 
The slope value obtained by the slope test is effective when performing 
isothermal analysis. This section describes the Slope Test.

Slope values refer to the numerical values for determining the peak start and end points.  •	
To be more precise, the peak start point is judged when a ascent slope exceeds the preset 
value, and, alternatively, the peak end point is judged when a descent slope falls below the 
preset value.

Optimum Slope values can be obtained from the data by the Slope Test. •	

�DD

1

This menu is displayed by right-clicking 
on [Chromatogram View].

To apply the measurement 
result to the peak integration 
parameters, click here.

To make preset values clearer, set a value rounded up to the 
nearest integer larger than the displayed slope value.

For example, set "200" for "195.218".  

�DD

The measurement result is 
displayed when the test ends.
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2  Set the Instrument Parameters

LabSolutions

SUPPLEMENT Default Folder and  
Change the Default Folder

1

This folder is the default 
folder.

Set this sub-window when changing 
the folder or creating a new folder.
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1	Open the [Data Acquisition] window.

2	Open the [Single Run] sub-window.

The [Single Run] sub-window opens.

Single Run
This chapter describes the operation of measuring a standard sample once only (single 
run) using a saved method file "Tutorial_Method.gcm".
First, perform single run using a standard sample.

Chapter

3
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3  Single Run

3	 Set the conditions for a single run.
In this example, set the conditions for pouring 100 ppm of alcohol mixed sample into 
vial No. 1 on the auto-sampler, and injecting that sample.

1

3

2

Enter "Test".

Vial# : 1

Click here to start the acquisition.

�DD Click here to cancel data 
acquisition midway.

The status changes 
to  when data 
acquisition ends.

�DD Data acquisition automatically ends 
when the [Stop Time] (15.00 min) set in 
the method file is exceeded.
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1	Open the [Postrun Analysis] program.

2

1

2	Open the [Data Analysis] window.

�DD Click here if the [Main] assistant bar is not 
displayed.

The [Data Analysis] window opens.

Data Analysis
After single run ends, check the data to see if the peaks have been detected correctly.
This chapter describes how to change the peak integration conditions of the data 
file "Test.gcd" obtained by performing single run to optimize the peak integration 
parameters.

Chapter

4
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4  Data Analysis

3	Display "Test.gcd".

Click  on the [Data Explorer] sub-window, and 
double-click "Test".

�$$ Refer to "Data Analysis" chapter in Operators Guide for details on the "Data Analysis" window.

Continued on the following page
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4	 Enter the peak integration parameters.

Width values refer to the minimum half-width value (height 1/2 width) of the peak to detect. 
Noise peaks are removed by optimizing the Width value. 
Determine the start and end points of the peak by the Slope value. 
The positions where the absolute values of the baseline slope become these values are the start and end 
points of the peak.

�$$ Refer to "Peak Integration Parameters" of the "Data Analysis" chapter in Operators Guide for 
details on the Peak Integration Parameters.

�DD

5 1

4
Width : 3 sec

Slope : 1000 uV/min

2

3

Click  to edit each 
parameter value.
Click  to perform 
processing on the data, and the 
processing results are displayed 
in [Chromatogram View] and 
[Results View - Peak Table].
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4  Data Analysis

5	 Enter the quantitative parameters.

�DD Click  to enlarge the 
window.

3
2

4

1

ZOOM 
UP

Quantitative Method : External Standard

# of Calib. Levels : 3

The [External Standard] method involves calculating concentrations ••
from the peak area (height) of unknown samples using a calibration 
curve made based on a standard sample.
At [# of Calib. Levels], set the number of concentration points for the ••
standard sample required for creating the calibration curve.
When creating calibration curves with the least squares method, set • 
[X Axis of Calib. Curve] to [Conc.].

�DD

5
X Axis of Calib. Curve : Conc.

Continued on the following page
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6	 Fill in the Compound Table.

1
2

3

Name Type Ret. Time Conc.(1) Conc.(2) Conc.(3)

1-Propylalcohol Target 5.754 100.000 500.000 1000.000

Isobutylalcohol Target 6.674 100.000 500.000 1000.000

Isoamylalcohol Target 8.705 100.000 500.000 1000.000

The result obtained by performing data acquisition is used for [Ret. Time]. ••
Selecting the [Ret. Time] cell, and clicking the peak in [Chromatogram View] automatically ••
enters the retention time of that peak to the currently selected [Ret. Time] cell.	  
The retention time can be set by simply clicking the mouse.

�DD

ZOOM 
UP

Click  to 
change the cell 
background color to 
yellow to fix the newly 
edited parameters.

�$$ Refer to "Compound Table Retention Times Using the Mouse" of the "Data Analysis" chapter in Operators 
Guide for details on setting retention times.
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4  Data Analysis

7	 Save the processing results to a data file.

Click here to save the processing results 
to "test.gcd".

8	 Save the method file.

1

Click here to open the [Save Method As] 
sub-window.

4

5
6

Click here to save the new 
data processing parameters 
to "Tutorial_Method.gcm".

To use saved data processing parameters for other data, perform either of the following operations to save the 
new data processing parameters to the method file (in this example, "Tutorial_Method.gcm"). 

Click [Save Data and Method File] on the [File] menu.•	

Click •	  (Apply to Method) on the [Data Analysis] assistant bar (operation in step 8 above).

�DD

2

3

Select "Tutorial_Method".

Set to 
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1	Open the [Realtime Analysis] program.

1 2

2	Open the [Realtime Batch] window.
�DD Click here if the [Main] assistant bar is not 
displayed.

The [Realtime Batch] window opens.

Realtime Batch
To perform data acquisition continuously on multiple samples (realtime batch), a Batch 
Table must first be created. Batch Tables can be easily created by using the table easy 
setting feature of LabSolutions.

Chapter

5
	5.1	 Create a Batch Table

In the following example, create a Batch Table with standard samples set to 1st to 9th 
rows, and unknown samples set to the 10th and 11th rows.
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5  Realtime Batch

3	 Edit the Batch Table.

1

In Batch Tables, you can set the sample information of each sample and output of reports.•	

�$$ Refer to "Edit Batch Tables" of the "Realtime Batch" chapter, "Edit Batch Tables" of the 
"Calibration Curves" chapter in Operators Guide for details on the editing batch tables.

When performing cleanup, enter "-1" in [Vial#] if the autosampler is used.•	

�DD

2

3

Set [Standard] to .
Vial#	 :	 1 to 3 
Injection Volume	 :	 1 µL
Repetitions	 :	 3 
Data File	 :	 Tutorial_Std

Click here to create a 
Batch Table made up 
of 11 rows.

Set [Unknown] to .
Vial#	 :	 4 to 5 
Injection Volume	 :	 1 µL 
Data File	 :	 Tutorial_Unk

4

5

Select [New].

Continued on the following page
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4	Copy a cell.

1

3

4

5

2

Select here.

5	 Enter a numbered series.

3

4

5

1

Select here.

2
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5  Realtime Batch

6	Directly enter remaining items to the Batch Table to  

	 create the Batch Table shown below.

7	 Save the batch file.

1

32

Enter "Tutorial_Batch".
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	5.2	 Realtime Batch Processing
Execute realtime batch using the Batch Table you created.

1	 Place the samples in the autosampler.

Vial 1 (level 1) Alcohol mixed sample 	 100 ppm solution (standard solution)

Vial 2 (level 2) Alcohol mixed sample 	 500 ppm solution (standard solution)

Vial 3 (level 3) Alcohol mixed sample 	 1000 ppm solution (standard solution)

Vial 4 Liquor (unknown sample)

Vial 5 Whiskey (unknown sample)

2	 Start realtime batch processing.

Click here to cancel data acquisition midway. 
To edit the content of the Batch Table during 
realtime batch, click  to pause realtime batch.

1 Click here to open the [Realtime Batch] and [Data 
Acquisition] windows simultaneously, and starts 
data acquisition from the 1st row of the Batch Table.
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5  Realtime Batch

LabSolutions

SUPPLEMENT

Print a Summary Report

1	 Add items to display in the Batch Table.
1

�DD The order of display items in the 
Batch Table can be changed by 
clicking [Up] or [Down].

3

4

2

Click here to add [Summary Type] and 
[Summary Report Format File] to the 
items to display in the Batch Table.

2	 Set up the summary report.

4

Select "SummaryReport_4".

5

After setting the summary report at Row Number: 1 
to 3, set Row Number: 4 to 6, 7 to 9, and 10 and 11 
in the same way.
Repeat step 2  onwards in the same order.

�DD

1

2

3

6

Row Number : 1 to 3

Continued on the following page
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3	Check the output configuration of the summary report.

When you have finished the output configuration of the summary report, execute realtime batch to 
print the summary report.

�Refer to $$ "5.2 Realtime Batch Processing" P.36 for details on executing realtime batch.

 [Printout Example]

Standard samples
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5  Realtime Batch

Unknown samples
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1	Open the [Browser] program.

2

1

2	Open the [Quant Browser] window.

Open the [Quant Browser] window.

Multiple Data Analysis
The LabSolutions [Browser] program is handy for checking the quantitative calculation 
results and chromatograms of multiple data. 
In the [Quant Browser] window of the [Browser] program, you can check multiple data, 
and change the data processing parameters of the currently displayed method file to 
modify calibration curves and perform postrun batch on multiple data.

�$$ Refer to "Quant Browser" chapter in Operators Guide for details on the "Quant Browser" 
window.

Chapter

6
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6  Multiple Data Analysis

3	 Load the batch file.

2

1

Drag and drop this file to display the 
quantitative results data.

Continued on the following page
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4	Confirm quantitative results.
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6  Multiple Data Analysis

LabSolutions

SUPPLEMENT

Modify Calibration Curves

1	Confirm peak integration parameters.
Confirm the peak integration parameters when peak detection is inappropriate.

2
3

1

Make sure that these 
values are appropriate.

Click here to perform 
postrun batch on all data.

ZOOM 
UP

Continued on the following page
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2	Confirm identification parameters.
Confirm the identification parameters and Compound Table when peaks are not identified correctly.

4 12

3

ZOOM 
UP

Make sure that these 
values are appropriate.

3	Confirm the Compound Table.

4 12
3

ZOOM 
UP

Make sure that these time 
settings are appropriate.
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6  Multiple Data Analysis

4	Confirm calibration points.

2

Confirm the calibration curve.

1

Make sure that the 
calibration point on the 
1st row is set to .

ZOOM 
UP

5	 Save the method file and data file.
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LabSolutions

SUPPLEMENT Export Quantitative Calculation Results
This section describes how to save quantitative calculation results as a text file.

1

4

2

3

5

Click here to save the "QuantResult.txt" 
file in the Sample folder.

Select [Output File], and 
enter "QuantitativeResult" 
as the file name.

Select [Items Displayed on 
the Screen].

Select [All IDs].

�$$ Refer to "Export the Quantitative Results" of the "Quant Browser" chapter in Operators Guide for details on 
exporting quantitative results.
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6  Multiple Data Analysis

LabSolutions

SUPPLEMENT Print the Quantitative Results Table
To print a browser report, select [Print] at [Print Table] on the [File] menu.

Select [Edit Format] from 
[Print Table] on the [File] 
menu to edit the report 
format.

�DD
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1	 Stop the GC.

ShutDown
Last of all, this chapter describes how to exit LabSolutions.

Chapter

7
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7  ShutDown

2	 Select [Exit] when the oven has cooled down.

3	Click [Yes].

When there is a file that has not yet been saved, a window to 
confirm whether or not to save the file when exiting the [Realtime 
Analysis] program opens. 

�DD

Continued on the following page
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4	 Exit LabSolutions.
If the [Postrun Analysis] program or [Browser] program is open, click [Exit] on the [File] 
menu of each program to exit the respective program.

5	 Shutdown Windows, and turn the PC and printer off.

6	 Turn the GC and peripheral devices off.

7	Close the main valve of the carrier gas and other gases.
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